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+ Helligkeitskorrektur L
(Tools> Add + Helligkeitskorrektur (Tools > Add Maptypes) als Gamma Werte statt +-

Helligkeit. Bei Bildschirm-Gamma (Config > Brightness) 2.2 entspricht

g/laptyp&c) als 0.45 original und 0.3 etwa dem bisherigen -128. Die Werte werden nun bei
amma Werte statt +- . . .

Helligkeit. Kontextumschaltung mit TAB mit dem Kartentyp gespeichert.

—Bel Bildschirm-

Gamma (Config >
Brightness) 2.2
entspricht 0.45
original und 0.3

—etwa dem bisherigen
-128. Die Werte
werden nun bei
Kontextumschaltung
mit TAB

—-mit dem Kartentyp
gespeichert.
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Version vom 16. Oktober 2017, 12:48 Uhr

+ libpng und libz statisch dazu gelinkt
+ font symbol und osm karten nun im png format

+ 4 kursor tasten zum karte verschieben und backspace fuer |etzte position(en)

(sofern die bei allen x11 gl ei chen hexcode haben)

+ osm karten in unterverzei chnissen nach zoom faktor 1..16

vor handene maps | oeschen oder einsortieren
+ wenn tiles fehlen wird sofern vorhanden die mit dem naechste zoomfaktor gedehnt eingesetzt
+ ./gm.sh starten bzw anpassen nach bedarf zum karten holen

+ linke maus auf karte klicken oder auf track oder symbol offnet menue

viele funktionen mt klick erreichbar aber noch nicht alle
nmenues noch chaoti sch aber mal zum testen

+ wetter grafik + statistik auf x11 abrufbar

+ ESC taste zum menues schliessen

+ funktion der klicks auf symbol/text/mapl/track getrennt konfigurierbar
+ 5 watch calls (ohne wildcard) statt "follow car”

+ wetter symbol etwas besser anklickbar (symbols.png)

(al pha kanal nach heller verschoben, sollte nal nach 255 wenn alle synbol e daf uer adapt

+ rechte maustaste = BACK SPA CE (back in zoom/pan-history) (bei www version lokal back am
browser)

+ map move stepsteil der fenstergroesse

6.1.2013

+ marker auf "Next click to Map": ohne einrasten auf symbole

"Next click to Synbol oder Text": mit einrasten auf genaue position wenn vorhanden
+ marker loeschen und keycode " @"
+ zoom to markers wieder da"Y"
+ kmh histogramm und animation entsprechend der eingestellten sichtbarkeits zeit des tracks
+ blaue popup menues sortiert nach der groesse angereiht von links oben

+ "Expandes Tiles" geht auch weg wenn alletiles 1:1



+ cdll in diewatchlist mit click

7.1.2013
+ Taste"@" umgewidmet auf "on click” Reset
+ Taste":" loescht beide Marker

+ 30s langer Retry Mechanismus zum Tiles Laden,

sobal d "gettiles" geloescht, je Sekunde 1 Ladeversuch aller benoetigten oder expandi ert
Tiles und was fehlt oder "png error"” hat wird erneut im"gettiles" angefordert.

7.1.2013

+ Tasten "<" und ">" entsprechend "Debug Track" raw+decoded Text der Waypoints oder Baken

dur chst eppen und setzt NMarker 1
+ Backspace history size 20 statt 10
10. 1. 2013
+ Tasten < > getauscht und Textinfo bleibt sichtbar

+ Click to WxSymbol neu und dort dann entweder 1 nicht-Wetter Messwert oder beliebig viele

Wetterwerte zugleich ein/aus schaltbar (Menue bl ei bt offen)

14. 1. 2013
+ Letzter Wettermesswert in der Kopfzeile der Wettergrafik
+ Wettergrafik passt sich der Fensterbreite an (ab 320 Breite)

+ Raw+Decoded Fenster bleibt trotz "Marker to Klick" Messdaten Fenster offen

16. 1. 2013

+ Decodiert positionless Wx Daten

+ Decodiert negative NN im "/A="-Format

+ Zoom to Markers geht auch bei Zoomlevel>14

+ Fractional Map Zoom rechnet etwa 2x so schnell und richtiger
+ Shift-Taste bel Map Move macht 1/10 Schrittweite

+ Shift-Taste bel Zoom (derzeit nur mit Maus) macht 1/10 Zoom Schritte

20. 1. 2013



+ Klick auf Track mit Raw+Decoded fuer den Geklickten Wegpunkt

+ Raw+Decoded mit Wegpunkt Nummer / Gesamtpunkte zur Orientierung wo man ist
+ Cut + Paste Puffer wird mit angeklicktem Call gefuellt

+ Paste in Texteingabefelder

- leider geht beides nicht nach aussen well die fenster heute mit "selections”

m tei nander tel efonieren und das ist etwa so aufwendig wi e das gesante interface
zum X11 bis jetzt

+ (derzeit noch nicht ein/ausschaltbares) Textfenster mit Scrollbalken fuer lange

Texte. Zum Test mit Rawdaten von tcp connect.

- nach 4 Tagen Suche noch nicht gefunden wie man Kill des Fensters abfangen kann

ohne dass dabei alles abschniert. Da auch die ganzen Xlib Aufrufe zum Text
reinzei chnen kei ner auf W ndoof/sontswas portieren wird, wi rds w eder abgeschafft.

26. 1. 2013
- Textfenster mal wieder weg

+ rawlog File wird nun auch nach dem Einlesen geschlossen und wie bisher beim Schreiben

fuer jede Zeil e neu geoeffnet

+ Marker 1 zu klick misst, wenn genau 1 objekt mit klick erfasst wird mit Einrasten

auf dieses, wenn "on next click set marker 2" inmrer ohne Einrasten
3.2.2013
+ (minimierbare) fixe Toolbar (die minimierte verdeckt noch manchmal Text Messages)
+ Popup Menues ausgemistet, z.B "Show All" nur wenns nicht schon ist

+ Von den neuen Kommandos aus der Toolbar gehen erst ein paar wirklich (W V Q S)

Messages, Listen, Config noch nicht

6. 2. 2013

+ Fahrtrichtungspfeil + Windfahne bel Wx Symbol, 20kmh pro Strich

bei des als Teil vom Synbol anklickbar und abschal t bar

10. 2. 2013

+ Auswahl ob Toolbar oder Popup Fenster, damit beim Start normale Toolbar daist.

Muss noch optimert werden was in wel chem Menue sein soll und was offen bl ei bt
oder verschw ndet. Hi stogranme verdecken di e Pulldown Menues aus der Tool bar



+ Hoehenangabe bei den Symbolen, noch nicht abschaltbar weil alle Symbol-Attribute

ab einemeinstell baren Wert (m ndest meter, km h) konfigurierbar erscheinen sollten.

13. 2. 2013

+ Text Editor mit Scrollen fuer Config und (wenn fertig) Messages, Parameter werden

erst einzel ne ausgewert et
+ Screenshot mit Filename

+ rawlog einlesen mit Filenamen (Datum Eingabe noch nicht ausgewertet)

16. 2. 2013

+ Watch Calls per Click suchen freien Platz in der Liste welil jetzt tastaturlos

auch wi eder abschal t bar

+ Watch Cals mit * als Wildcard

+ Setzen der Start Map Position auf Bildmitte per Lokator, Long/Lat, oder mit "?"

imConfig und dann Marker 1 setzen auf der Map
+ eigene Position im Config auch mit "?* mit Marker 1 uebertragbar.

+ Config File Speichern/Laden beim Start verwenden und automatisch bel Quit

Spei chren

- fehlt noch Auswerten einiger Config Parameter zb Helligkeiten und "next click to Wx"

15. 2. 2013

+ Ausser Igate/Network und LogDatum Configs sollten alle gehen und gekoppelt sein mit den

Schi eberegl ern. Manche Werte, die beimteilweise ei ngegeben sein Unfug nachen,

erst bei "Save" "Rel oad" oder Start ausgewertet.

28. 2. 2013

+ Bel Click auf Pixel das zu mehr als 1 Objekt gehoert, werden die gefundenen Objekte

bei jedemweiteren Cick der Reihe nach an die 1. Stelle cykliert
+ Logfile Import mit Datum + ganze Stunde

+ Netbeacon aus Configparametern damit per Modem empfangenes ein Symbol fuer MH hat

(noch nicht per tcp gesendet)

wer den



3.3.2013
+ Objekte Loeschen

+ Filtern von Call, Igate, Objekt/Item-Absender (erst mal ohne Wildcards)

7.3.2013

+ transparente Menues oder schwarzer oder grauer Hintergrund
(Config Transparency 2..100, 1, 0)
+ Config Baken Symbol mit Auswahimenu ("My Symbol" clicken)

+ Objekt loeschen mit DEL-Taste

17. 4. 2013

+ Nach wochenlangem Kampf mit den Windoof Compilern ist nun etwa Gleichstand bei der

W n32 Version und es kann w eder am genei nsanen Teil weiter gebaut werden.

Die innere Struktur ist etwas ungekrenpelt zwecks m nim ertem syst enabhaengi gen
Teil. Leider hat sich die "Tile" Filestruktur (mit schnell nal 3500 Files in einem
Ver zei chnis) am Wn als Brense erw esen und daher ist noch eine Unterverzeichnis-
Ebene dazu gekommen und die Struktur nun gleich wie auf den Servern und "Marble".
Zum Konvertieren der vorhandenen Maps ist das "rentile" script dabei das man

noch anpassen muss und mt der Komrmandozeile, die drin angegeben ist, Aufrufen.

Es wird nix geloescht nur kopiert. "gmsh" ist auch darauf angepasst.

+ Neu sind nur ein paar Filter im Config und fuer Besitzer eines Mausrades damit Zoomen

und Pull der Map mit der mittleren Maustaste. Fuer Touchpad-geschaedi gte nmuss man sich
noch eine Alternative nmt Shift/Alt oder Kl ick auf die | eere Map ausdenken.
Screenshot geht nun auch als "bmp" wenns File .bnmp heisst.

17. 4. 2013
+ Pull Map auch mit linker Maustaste auf leere Map (configurierbar ?)
+ Shift + Click to Map: Set Marker 1 (configurierbare andere kommandos ?)

+ On next Click to Wxsymbol: Raw+Decoded zu den Wettergrafiken dazu einschaltbar

20. 4. 2013

+ tcp Connect zum Server mit neuer Syntax, -g <ip>:<port>[#<filter>] -g 44.143.100.1:14580#m/300

MYCALL und PASSWORT jetzt schon aus dem Config statt -s -p

+ Netzbake: "File" > "Config" -> Mycall, MyPos, Net Beacontext, My Symboal,

Net beacontine nmit Enable, PassCode nit Enable
My Synmbol Anklicken fuer Auswahl
My Position "?" an 1. Stelle und dann Marker 1 Setzen



29. 4. 2013

+ tcp Connect nun probisorisch im File>Config, wenn man editiert gruen ausschalten und wenn

fertig w eder ein.

+ auf Wunsch Massstab auf der Karte (noch nicht schaltbar) und auch problematisch wegen

ni cht entfernungstreuer Merkator Karten bei klei nem Zoom

4.5.2013

+ Vorschlag von di8rdl eingebaut, Maps Download im Hintergrund kompl ett fuer das sichtbare

Fenster von Zoom 1 bis einstell barem maxi mal en Zoom mit Vorkal kul ati on der Dat ennmenge,
abbrechen, weitertun, und Fortschrittsanzei ge.

+ Messages empfangen (derzeit erst von tcp)

6. 5. 2013

+ "DAQ"-Erweiterung in Frame-Decoder eingebaut zum Position auf etwa 20cm genau uebertragen

und auch genauere Auswertung vom GPS-raw Format und Anpassung der Rundung auf Fel dmitte
(leider ist die fliesskomm Genaui gkeit nur etwa 1-2n)

8.5.2013

+ Mehr Status Meldungen von "on/off" Schaltern und (Shortcut) Funktionen

+ <Make Video> legt "map.y4m" auch auf Linux neu an wenn nicht (zB. als named-pipe) vorhanden,
mel det Schrei bvorgang, refresht alle 1s den Bildschirmund ist abbrechbar.

+ Buttons mit noch nicht implementierter Funktion melden das.

+ Im Screenshot Filenamen wird "%t" durch Datum-Uhrzeit und %n durch 000" bis "999"
ersetzt bis der Filename neu ist.

+ Shortcut Tasten Listeim <Help>

10. 5. 2013

+ 4 direkt waehlbare Map Positionen + Zooms im Zoom-Menue oder per "1..4" Tasten.

Dabei kann entweder der Zoom evel oder die Position oder beides abgerufen werden.

Der Eintrag dieser "Views" kann nmanuell im File>Config>View durch "Zoonfaktor Position'
(wobei Position auch ein QIrH Lokator sein kann), oder eines von bei den, oder viel
schneller durch "Shift" + dick auf einen der 3 "Views" im Zoom Menue erf ol gen.

Dabei wird die aktuelle Karten-Position mt Zoom gespeichert.

Shortcuts anders: "1" (one user) nun "."



n 2Il +rf nun n :ll
"On next click" neu einstellen erforderlich

12. 5. 2013

+ Tooltipps mit Text aus externem File "hints.txt" und schon etlichen Texten drin.

Darf natuerlich verbessert oder uebersetzt werden wobei das Ergebnis der Arbeit
sofort aktiv ist sobald das hints.txt gespeichert ist.

| But t onnummrer Text

di e fehl enden Texte werden als "<Buttonnunmer> hint text" gezeigt

die Struktur des File>Config wird noch ungebaut daher nit den hints dafuer abwarten

15. 5. 2013
+ "Zitter"-Toleranz fuer Mausposition innerhalb der die Hints sichtbar bleiben + Zeigt aktuelle

"Mbytes written" des Video Files + List>Internals zeigt System Zustand + "L" Shortcut nun "toggle
Labels on/off" Labels=Text bel den Symbolen + Fine Zoom Stepsim Config

17.5. 2013
+"L" und "O" bzw "Labels off" "Objects off" wird nun nimmer in Form von 0% Helligkeit
imConfig verew gt

+ In Vorbereitung auf ein Text-Fenster kommt nun mal List>Messages und List>Bulletins

auf das Start Term nal Fenster raus, wobei die Bulletins noch nach
Absender/Ei ntreffzeit sortiert sind und nicht nach der BLN<nunmer>

+ Angeklickte Objekte kann man in Infos>List Raw oder Infos>+Decoded auf das Textfenster

auflisten [ assen (ohne farbige Fehl ernmel dungen)

18. 5. 2013

+ Config>Show Incoming "n" Zeigt TCP-Frames auf dem Textfenster, "n+" Dekodiert

fuer die Radio Ports entsprechend 1 2 3 ... und 1+ 2+ ... Dekodiert

21. 5. 2013
+ Raw+Decoded Sprechblase aktualisiert sich mit ankommenden Daten falls sie den letzten
Wegpunkt anzei gt

+ Delete Waypoint, wenn mit Debug oder Raw+Decoded markiert. Mit DEL-Taste zum entfernen

von (fal schen) Wegpunkten. Marker 1 springt dann zum naechsten (vernutlichen) Fehler w«
(Wann al l es | oeschen oder nur Waypoi nt muss noch besser definiertbar sein)

+ Hoehe wird auch bei Symbolen ohne km/h Daten angezeigt falls Hoehendaten vorhanden und



ei ngeschal tet.

23.5.2013

+ UDP-Port im Config (erst mal 1 Stueck) + Fenstergroesse veraendern schneller + Trackfilter
Fehlererkennung verbessert + Bei Debug Funktionen V erzoegerungszeit von doppelten Waypointsin
Sekunden sichtbar

29. 5. 2013

+ Zwecks schnellem Tracks Debuggen mit "E" oder File>Infos>Waypoints-Button toggelt

all e, oder nur die als verdaechtig narki erte Waypoi nts anzeigen nmit den "<"">" Tasten
oder den Buttons daneben.

+ rawlog mit lesbarem Datum/Zeitstempel, das alte Format wird lesend auch akzeptiert.

+ axudp-kiss (usb)seriell Interface (udpflex) erweitert, sodass nebst an/abstecken von

usb-Seriellen auch ein resetteter TNC2 an enpfangenen (nun nicht nmehr kiss) Daten
erkannt und wi eder auf Kkiss geschaltet wird. Geht mit init File auch fuer andere TNC
wi e in THD7x oder TMD7X.

udpflex (linux), udpflex.exe (w n32)

8. 6. 2013

+ Configurierbare default Speed fuer Animation + Parkplatzzittern-Erkennung fuer Animation
Startzeit verbessert + Source Code Entruempelung zum einfacheren Compilieren fuer verschiedene
Prozessoren

15. 6. 2013

+ km/h und/oder Hoehe in Animation und Video wobel Lesbarkeit bei schneller Aenderung

noch verbessert werden kann.

+ Uhrzeit beim Log schreiben laeuft nun auch waehrend Animation in Echtzeit. + +-24h Zeitversatz
Systemzeit/angezeigte Zeit einstellbar

5.7.2013
+ Objekte mit extra "keep in memory time" zB um den schon nach 5 bis 6h recycelten
Bl it z- Obj ect - Namen kei nen Track erzeugen zu | assen.

+ Logfile browsen geht gleichzeitig mit online Betrieb. Dazu wurde eine zweite

Uhrzeit geschaffen die den Logdaten fol gt und die Echtzeit Daten werden unabhaengi g
von den Logdaten (wi e sonst auch) im RAM und witel og gepspeichert.



Es kann jederzeit zwi schen Log und Echtzeit gschalten werden und in den Logdaten
an Anfang, Ende, und in "Fullbright" Zeitspruengen vor und zurueck gegangen werden
womt imrer alle Daten einmal sichtbar sind.

+ Status Bar zeigt Betriebszustand, erst mal experimentell zum sehen was man braucht

mt Buchstaben bis Synbole entworfen sind. Bei TCP (Internet) und und UDP ( Funk)
wandert die Farbe von gruen nach rot binnen 1 Mn. solang kei ne Daten ankommren.
Message soll mal anstatt dem Popup Fenster vorhandene Messages anzei gen und erst bei
drauf kl i cken Inhalt zeigen.

16. 7. 2013

+ Hoehen Diagramm ueber Wegstrecke, mit Trackfiler on "F" wird versucht die manchmal
ungenaue Hoehenmessung etwas gl att zu buegel n.

+ Beim Track anklicken wird der Wegpunkt ausgewaehlt der der Klickpunkt am naechten
liegt.

+ Popup Meldungen, die Befehle bestaetigen, werden nach ein paar Sekunden wieder

entfernt. Da, um CPU Zeit zu sparen, der Bildschirmnur aktualisiert wird wenn neue
Dat en komm, geschi eht das Loeschen nur i m Zuge ei nem Updat es.

19.7. 2013

+"On Next Click To Track" mit Speed oder Altitude aktiviert, setzt eine Marke auf

dem Di agranm di e der angeklicken Stelle am Track entspricht.
+"On Next Click To Track" kann mit 1 Click Wegpunkt loeschen aktivert werden.

+ Ein angewaehltes Objekt kann mit "Save" as Logfile mit dem Filenamen des Objekts

gespei chert werden (derzeit nur im Startverzeichnis). Existiert das File, wird
hi nten dran geschrieben. Es werden alle Daten aus dem RAM geschri eben auch wenn
mt Trackfilter oder Fullbright Tinme ausgebl endet.

Manuel | gel oescht e Baken/ Wegpunkte sind weg.

22.7.2013

+ Video/Animation Speed Einstellbereich erweitert von 1:1 (Echtzeit) bis 200s/Frame

wom t di e Speed-Zahl statt (Echt-)Sekunden zu Frames jetzt multiplikator fuer
Echtzeit ist.

+ Start Delay fuer beschleunigte Darstellung (wenn sich nichts bewegt) einstellbar

+ Log Import fuer ein Call wobel immer auf eine Zeitspanne gesucht wird in der das

Call aktiv war (keine w ldcards)

25.7.2013



+"On Next Click" mit mehreren Optionen gleichzeitig (wo es Sinn macht).

9.8.2013

+ Durch erweitern der Menue-Darstellung auf Tabellen mit Farben und verbessern des

Zeilen-Editors (Maus kann Cursor setzen ...) ist Messages erstellen und verwalten
noegl i ch geworden. Enpfangene Messages sind noch ohne Tabelle.

2.9.2013

+ Nach komplettem Umbau des Konfigurations-Tools mit dynamischer Anzahl der

Ei ntraege geht nun Messages senden, nehrere Aprs-Server-urls die abgekl appert
werden bis einer antwortet, beliebig viele Watchcalls, Filtereintraege, Baken..
Der Texteditor kann Insert/Overtype und Cursor setzen mit der Maus.

Mt Shift-Linksklick auf die Karte wird die Position in die Editorzeile

kopi ert (jetzt einfach w ederhol bar bis man "getroffen" hat)

(Die eigene Position und die Zoormr"Vi ews" mnuessen neu ei ngegeben werden)

+ Die aktuelle Fenstergroesse wird im Konfigfile mit gespeichert.

"View 1" wird beim Progranmstart dargestellt.
(spei chern der aktuellen Ansicht mit Shift-Linksklick i mZoom Menue)

+ Nach der Frage "was brauch ich alles um online zu gehn" ist diesnunin

ei nem Menue. Dabei kann man abgestuft von ganz ohne Call bis Call und eigene
Position nur dem Server sagen (zwecks funktionieren der mi... Filter) bis
Bake und Messages ins Netz senden konfigurieren.

+ Igate-Funktion ist nur in der Linux Version vorhanden da das Win-tcp-System

kei ne I nfo ueber bestaetigte Daten hat und dann einen als "haengend"” erkannten
Li nk nicht term ni eren kann, ohne die veralteten Daten noch rauszuwei nen.

Das waere im aktuellen Aprsls-Netz ohne Tinestanps nicht nehr akzeptabel.

Auch die Linux |gate-Funktion sollte auf keinen Fall fuer einen Digi verwendet
werden da zB. beim Logfil es durchsuchen die Durchlaufzeit erheblich werden kann
Fuer lgate gi bts ohnhin ein eigenes Tool.

+ UDP-Ports fuer Funk rx/tx mit Soundmodem oder mittels "udpflex" (USB)seriellen

TNC gi bts derzeit 4. Eine dynam sche Anzahl braucht noch Aufwand bei den
Schal t knépfen in den Menues.

Der Funk-Baken/ Qbj ekt/Itens-Editor ist noch in Entwi cklung, dort dann auch
wi eder di e verschwundene "Rfbeacontinme" fuer jede Bake extra
(bis da hin 1 Bake nanuel |l ins aprsmap.cfqg)

4.9. 2013

+ Baken senden mit Macros fuer Uhrzeit und File einfuegen (Wetterbake). Jede Bake

mt Port und Intervall Angabe und Ziel port geht auch Net. Mt Beacons Shift Tine
wird die Startzeit jeder weiteren Bake so verschoben, dass sie nicht innerhalb der
"dupe delete" zeit (neinst 57s) der |gates |anden.

Syntax: intervall(s):port:rawfornmat 600: 1: NOCALL>CQ >t est

\\z tag+zeit, \\h zeit, \\:filenane:, \\\ \\



8.9. 2013

+ Maus Hint Texte verbessert und deren Erscheinen an der Status Bar. + User Infos erweitert,
gefahrene km, Zaehler fuer Baken, Messages, Acks, Rejects

9.9.2013
+ "Show Objects of Sender" zeigt alle (anderen) Objekte und Items von dem Absender
des Ausgewaehl ten Obj ekts auf einer dafuer gezoonten Karte unter "Info>Chjects of.."

+ Shift-Click auf die Status-Bar (die bunten Laempchen) oeffnet direkt das zugehoerige

Confi g- Menue soweit Sinnvoll.

11. 9. 2013

+ Menue Positionierung korrigiert und Menues nimmer schliessen bel Shift-Click

auf Map zum Position in Editor Zeile kopieren

13.9. 2013

+ Statusbar Netzwerk-Buttons Mouse-Over wenn nicht online normale Hints,

wenn online, Status Info. X/ N zeigt offline/online (sollten nmal Synbol e werden)

+ "w" Temperatur-Karte wie bisher, "W" (w mit Shift) Regen-Karte mit blau fuer

24h und rot fuer aktuellen Regen (noch ohne Fehlerfilter, |uegende Stationen
anklicken und mt DEL entsorgen).

16. 9. 2013

+ Logfile lesen mitn Binaersuche fuer den Anfang ab wo ins RAM eingelesen wird

mt dem Vorteil, dass auch | ange Logs bei m Programstart und Log Inport schnell
nach Datum durchsucht sind, aber das Logfile nmuss nach Datum sortiert sein.
Derzeit max 4GB Logfile.

19. 9. 2013

+ Message (Query) Kommandowoerter + Antworten in Config > Rf-Ports.

Standard Querys (?APRSP) al s auch beliebi ge Wherter koennen definiert

werden und in der Antwort Macros wie \\h Uhrzeit, \\p Path, \\I Position,

\\v Programm Version, \\<filenane> File senden, \\>fil ename> schrei ben,

| et zteres zum aktivieren von ei nem Programm zum was St euern oder Sprachausgabe
"TALK:\\ >/t np/tal k. txt>Text um\\h Gesprochen!"

" ?HELP: ?APRSP, ?VER, TALK"



22.9.2013

+ Windfahne und Temperatur beim Symbol mit Timeout. + 1 Kommastelle mehr bei Koordinaten-
Ausgabe und bei Maus-Koordinaten

Grad/ M nut en/ Sekunden- Schr ei bwei se zuaet zli ch.

+ Win32: bel der (oder mehr) Start-Fenstergroesse die der Bildschirm kann,

"Maxi m zed" Fenster.

7.10. 2013
+ Filesystem auf "Longfiles’ umgestellt damit sollte Logfile >2GB geschrieben
und dank Bi naersuche auch flott inportiert werden koennen.

+ Programm Starter fuer Maps-Downloader bel Bedarf (gm.sh bzw gm.bat)

der kann sich nach getaner Arbeit beenden. Status in der Status-Bar
mt "D' statt "E' fuer Downl oader |aeuft erkennbar.

+ Beliebige Map-Typen configurierbar mit korrektur der Basis-Helligkeit,

die ersten 3 wie gewohnt nmit Shortcut "7" "8" "9", die 1. beimStart aktiv.
Sat - Maps erst wenn ein JPEG Dekoder vorhanden ist (ausser man wandelt
sie beimDownload in PNG. Neu (voreingestellt): cyclemp

11. 10. 2013

+ Wegstrecken Summe (ohne Track) auf der Map (shift-click, click, click...) + Log Import (bis auf
Suche rueckwaerts nach Call) bei unsortiertem File

versucht etwas zu verbessern

13. 10. 2013

+ Schriftgroesse einstellbar (Config > Map Paramter > Font Size)

15. 10. 2013

+ Screenshot auch als".png" (vorerst nur Linux Version)

und osm Ver zei chni spfad w eder configurierbar

+ "On next click to Track" bei mehrfacher Auswahl mit "Zoom to" wird erst gezoomt

und dann im 1 Track Mbde di e anderen Funktionen aktiv.



31.10. 2013

+ Beep-Sounds mit beliebiger Frequenz und Dauer wenn Message oder Ack eintrifft,

wenn sich wer in den WArnradius bewegt nit steigender Frequenz und/oder Dauer

j e naeher er zum Zentrum kommt und wenn ein Call aus der Watch Liste aktiv wrd.
Al'le getrennt schaltbar und limtiert auf maxinmal alle 5s.

W ndoof 7 oder 8 geschaedi gte koennten evtl. keinen Piepser haben dann gibts als
Ersatz 3 System Sounds (mit Onms einschalten, bis 500, bis 1000, ab 1000Hz
jeweils ein anderer Gong).

Config > Map Moving > Bel |/ Sound

6. 11. 2013
+ In Animation und gedimmten nicht-movern wird die schrift der "mover” im
nun Vordergrund gehal ten

+ Einfaches Hyperlink Hilfetext System mit File "help.txt" unter "Help"

errei chbar mit ein bisschen Text als Beispie

18. 11. 2013

+ Einstellbarer Timer zum Verzoegern vom Mapdownload Start waehrend Karte

ver schi eben, wer so verneiden will, dass in hohem Zoom der Streifen an Karten
entl ang der Bewegung durch die Botani k gel aden wird. Config / Timers

+ Index Taste im Help Fenster

+ Schutz vor ewig loopenden Mapdownloads wenn durch zB volle Platte oder nicht

i denti schem Schrei b/ Lese-Pfad i nmer di e gl eichen Karten angefordert werden.
Kommt ein Kartenteil immer wi eder, wird nach ein paar Versuchen 1. nur nehr
1 Karte angefordert, 2. die Pause zw schen Anforderungen i mmer Verdoppelt
und 3. poppt eine Fehl ernel dung auf.

+ Copy/Paste hinein ins Program (rechte Maustaste im Textfeld oder ctrl-v)

(bei linux jetzt mt dem aktuellen "keiner verstehts..." selection-Verfahren)

22.11. 2013

+ "Ok" im config-Zeileneditor schliesst das Fenster nach dem Speichern. + Map download Timing (im
Fehlerfall) optimiert, dass mit dem in entwicklung

befi ndl i chen hochgeschwi ndi gkei t s- Downl oader von oe5krn bei fal scher
Ei nstellung oder voller Platte keine "G gabyte"” ins N rvana gel aden werden.

28.11. 2013

+"B" und "M" (gross) fuer Bakeneditor und Message senden



+ Index bei Helptext

+ Umfangreicher Baken/Objekt/Item Editor mit verschiebbarem Fenster,

I mport von vorhandenen Obj ekten auf der Karte durch anklicken

Testen | okal vorm Senden.

Ei nnal senden oder mit Tiner und Verschi ebung der Sendezeiten, dass die
Dupl i katl oeschung in den | gates Sendungen nit gleichen Inhalt aber

ver schi edener Frequenz (oder direkt per tcp) im Netz sichtbar |aesst.

Ei nf aches Fernl oeschen von |Items und Objects.

Normal / M c- E/ Conpressed mt DAO Erweiterung fuer 20cm Genaui gkeit

(die aber je nach Fliesskommuarithnmeti k nur etwa 1m schafft)

mt Bytezaehl er der Gesantl aenge beimeditieren der Kommentarzeile zum
optim eren der Konpressionsart.

Macr os zum Ei nfuegen von Files zB fuer Wetterbake

+ Query standard Antworten (?APRST ...) vorkonfiguriert mit opt-out wers
nicht will. Config > Rf Ports > Query Keywords
+ Fehler behoben, Decodieren von Items mit kurzem Label.

Unsi cht bare User wegen kei nem oder fal schem Synbol (die aber trotzdem
wat ch/ appr oxy- pi epsen) haben nun Label und Track

+ Listingsim "Show 1 Modus" zeigen nun nur was zu dem User gehoert

4.12. 2013

+ Config > Rf-Ports > Monitor Headline

Damit kann man O bis 20 Calls + Tenpertur oder kmih als "Ticker"

von aktuell en Franes auf der Fenster-Ueberschrift durchlaufen | assen
Bei mnimertem Fenster ist das aktuellste Call in der Taskl eiste.
N> komt von, N< get ans Netz, 1> 2> Funkports, N heisst der Frane
ist entweder in den Callfiltern oder ohne verwertbarem I nhalt.

+ (grosses) "F" Shortcut Find (Call, Locator, Breite/L aenge)

+ Bakeneditor "Draw" schreibt nimmer ins rawlog

10. 12. 2013

+ Calls + Temp,km/h,Hoehe der ankommenden und abgehenden Daten in der

Fenst er - Kopf zeil e. Anzahl der Calls Config>Rf-Ports>Monitor Headline.
Updaterate auf (Mttelwert) 1s linmtiert.

+ Maus-Verhalten umgestellt (aehnlich anderen Programmen).

Li nksklick wartet auf Maus-Bewegung (mt ein bisschen Zitter Tol eranz)
und zieht Karte (auch wenn ein Synbol getroffen) oder, am oberen Rand
angef asst, konnen ei nige Menues und die Status-Bar positioniert werden



mt "ankl eben" an den Fensterrand und gespeichert in aprsmap.cfg.
Bei m ausl assen der Maustaste, wenn nicht bewegt, wird der normale Klick
ausgel oest.

Mttlere Maustaste zieht alles was ziehbar ist und an beliebiger Stelle
angef asst.

Rechte Maustaste wi e bi sher Back-in-zoom H story oder in einer
Text ei ngabe "Paste" (falls was i mcopy/paste Puffer ist)

15. 12. 2013

+ Message Senden nun bis 67 Zeichen wie im Protokoll vorgesehen statt 57. + Umlautwandler auf "Ae
OeUess' (hismal ein 8 Bit Zeichensatz definiert ist). + Message Eingabezeile geleert wenn die
vorherige M essage abgeschickt wurde oder

an ein anderes Call als zuvor gesendet werden soll

+ Schnelles Zoomen mit Shift-Linksklick und Rahmen um den gewuenschten Inhalt

auf zi ehen.

+ (nur Linux) jpeg-Dekoder fuer Maps wobei erst .png versucht wird dann

jpeg in .png Filenamen und zuletzt jpeg als .jpg (gmsh nodifizieren).

16. 1. 2014

+ Config / Online/ Serverfilter Aenderungen werden bei "Ok" sofort zum

Server geschickt. (sofern der die "# filter ..." Syntax versteht)

+ mit "<" ">" durch einen Track wandern geht mit gleichzeitig geoeffneter

Al titude- und Speed-Statistik und zeigt dort die Stelle am Track und die
Messwerte numnerisch.

+ Tools/ List neu mit verschieb- maximier-, ikonisierbarem Textfenster

mt Scrollbal ken (und Cursortasten und Mausrad) und nach Zeit und

al fabetisch sortierbaremlInhalt.

Es kann Rohdaten und dekodiert |isten. Text kann nman marki eren und mt
"Paste" in andere Anwendungen kopi eren (auch auf Wn ohne unstaendlichen
Dialog). Gbt nan in Tools / Find ("F'-Taste) ein Wrt ein, werden alle
gl ei chnami gen Stellen farblich hervorgehoben zB. "APLM)1" oder ein Call.

Klickt man auf eine Zeile, wird auf der Landkarte di e Herkunft gezeigt,
sofern die Zeile eine Position enthaelt und wenn nicht, die letzte
bekannt e Position vom Absender der Zeil e.

Das Live-Mnitor-Fenster fuer enpfangene und gesendete Daten hat anstatt
sortieren "Clr" fuer Inhalt |oeschen, es stoppt raufscrollen wenn man

m ndesten 1 Zeile herunter geschoben hat, und kann mt "u"-Taste an und aus
geschal tet werden. (Beachten: bei Batteriebetrieb durch den | aufenden

Bi | d- Update evt|l mehr CPU Akkuver brauch)

Das Aktivieren des Mnitors ist, bis eine sel bsterklaerende Menue- Struktur
erfunden ist, noch wie zuvor unter Config / Rf-Ports / Monitor Franes.



+ Linux: F11-Taste (bel "seltsamen™ Fenstermachern die selber kein Maximieren

oder dann wi eder kl ei ner machen koennen) toggelt Fullscreen/ Nornal .

+ Win: Kein extra Textfenster mehr da Listings eingebaut.

20. 1. 2014 (Ver 0.32)

+ Funkport (Soundmodem / udpflex) Kommandozeile in Config / Rf Ports/

Serial Interface
Task wird automati sch gestartet.

+ Monitor Ports off/raw/decoded einzeln mit Klick schaltbar Tools/List/Monitor.

3. 2. 2014 (Ver 0.32)

+ Message Rx: Schalter fuer Pop-up Fenster

Schal ter fuer zeigen von Messages an andere SSID
Schal ter fuer Messages an sich selber weg filtern (default on)

6. 6. 2014 (Ver 0.34-testversion)

+ Hoehendaten (soweit in einem Datenfile vorhanden)

bei "show Location of Muse" "on" werden m ueber NN angezei gt
ebenfal I s neu, Distanz und Wnkel zum Marker 1 wird angezei gt

Files zum sel ber besorgen:
osni srtnB/ NA8E012. hgt
N48E013. hgt

(90m aufl oesung, 1x1 grad 2.8MByte pro File
http://dds.cr.usgs.gov/srtmversion2 1/ SRTM3/ Eur asi al)

osni srt nB0/ WO20N90. DEM
(900m aufl oesung, 20W.20E, 40 bis 90N 57Byte, deckt den Rest ab
http://dds. cr.usgs. gov/srtnmversion2 1/ SRTM30/)

osm eudeni (noch nicht inplenmentiert)
30m Auf | oesung, 640MByte fuer 5x5 grad, braucht aber erst konvertierprogramm
vom (unbrauchbaren) "eu-geotiff" in | esbares Fornat
http://ww. eea. eur opa. eu/ dat a- and- maps/ dat a/ eu- dem#eeaEsr i Map

+ Radiolink Berechnung zwischen Marker 1 und 2 nach Eingabe von Antennenhoehen

und Wel | enl aenge. Vorerst mal Darstellung auf der Map als farbige Fresnel zone
"blau" frei, "gelb" bis "rot" von angekratzter 1. Fresnel zone bis voll verdeckt.

+ Radiolink mit 2 Klicks oder fuer tastaturlose Bedienung

"On next click to Map" mt "Set Marker 1" beim 1. Klick und Marker 2 bei weiteren
Kl icks nach "Cl ear Markers" wird wi eder erst Marker 1 gesetzt.

+ "d" Shortcut fuer Map downlod on/off


http://dds.cr.usgs.gov/srtm/version2_1/SRTM3/Eurasia/
http://dds.cr.usgs.gov/srtm/version2_1/SRTM30/
http://www.eea.europa.eu/data-and-maps/data/eu-dem#eeaEsriMap

+ Map download auch wenn auf "off" wenn "Reload" oder die Download funktion

betaetigt wrd.

+ Testweise "High Resolution Track™ Dekodierung a's Protokollerweiterung eingebadi.

Dabei werden mit einer Bake 2 bis 30 Positionen gepackt als Abwei chung von ei ner
Geraden 2 oder 3 dinensional + Tinmestanp uebertragen. Wrd die Erweiterung nicht
erkannt bleibt die normale Position pro Bake.

Die Optionen sind erweiterbar, Positionsaufloesung, End-zu-End Pruefsunme,
"QRV"-Frequenz, direktgehoert von lIgate, Cinb-Rate und fuer Wanderer hoehere
Geschwi ndi gkei t sauf |l oesung sind mal vorgesehen. Traegt sich der direkthoerende
Igate ein, wird vom Aprsls-Service eine veraenderte Kommentarzeil e erkannt und

damt ALLE lgates ersichtlich, die direkt gehoert haben und nicht nur der mt

der schnell sten G asfaser Anbi ndung. Dekodiert wird dabei eine in vom Enpfangsnodem
in Klartext ungesetzte Darstellung fuer Aprsls. Am Funkweg wi rd bi naer und wesentlich
kl ei ner gepackt uebertragen.

13. 6. 2014 (Ver 0.35-testversion)

+ osm/srtm1/N48E012.hgt

mt 30m hori zontal er Aufl oesung aus den EU- DEM Daten unformatiert in das srtml-Format
wi rd bevorzugt verwendet.

+ UDP-Ports restarten sich wenn beim Editieren was veraendert wurde. + Map Loader startet beim
enabeln ohne nochmal herumzoomen. + Speed/Altitude/Gel aendeschnitt-Diagramm updatet sich mit
ankommenden Daten wenn

mt |etztem Wegpunkt oder Synbol anklicken geoeffnet.
+ Igate (Rf to Net, nur Linux) jeder UDP Port kann einzeln freigeschaltet werden

+ Gelaendeschnitt, Darstellungs-V ersuch mit zusaetzlichem Freiraum-Diagramm auf der

Landkarte. Praktisch zum Zoonen aber evtl. m ssverstaendlich da nur die Fresnel - Zone
zur Karte passt und folglich die Punktrei he, die di e Bodenhoehe darstellen soll, nicht.

17. 6. 2014 (Ver 0.35-testversion)

+ Sichtweiten Farbkarte, mit Marker 1 oder 2 oder beiden gesetzt, wird mit "R"-Taste

die optische Sichtweite dargestellt. Antennenhoehen am Marker ist 1. Wert in

"Tool s/ Radi ol i nk" am andern Ende gilt Wert 2. Die Wl lenlaenge wird hier auf 0 gesetzt
und danmit ist ab hal ber Fresnel zone "Sicht". Farbhelligkeit in

"Confi g/ Map Paraneter/Brightness Rfpath"

Di e Berechnung i st noch experinentell und sollte nach optim erung deutlich schneller
werden und danmit nman die Landkarte noch | esen kann brauchts noch Darstellungs-ideen.

28. 6. 2014 (Ver 0.37-testversion)

+ Marker setzen mit Einrasten auf die genaue Position eines angeklicktes Objekts

(More Infos> ) und ohne Einrasten i m Zoom Menue. Dort auch Marker einzeln Loeschbar.
Marker 1 als "hart (gelb)" oder "weich (blau)", |etzerer entsteht durch einfaches



Ankl i cken, bewegt sich nit fahrenden Objekten bzw. huepft auf neu angeklickte Objekte
oder Wegpunke und hat ein Tinmeout. Harter Marker bleibt bis |oeschen.

+ Netz/Funkport Status-L aempchen zeigen nun letzte Sendung (gelb) und letzten Empfang
(gruen) seit 60s als Sanduhr.

+ Mausrad (oder Zoom-Menue +/- mit Shift) Zoom Stufen (Config/Map Moveing/Fine Zoom Steps)

rastern nun die automati schen Zoonvorgaenge auf die eingestellten Wrte insbesondere
auf "1" also original Osm Stufen.

+ Ausgeschaltete Tracks (Helligkeit auf 0) machen nun auch Funkwege und Zoom auf das

was man noch sieht.

1.7.2014 (Ver 0.38-testversion)
+ Watchliste neu mit Schalter fuer Pieps/ Landkarte mitbewegen / Logfile
zB. mit OE* getrennte Logfiles fuer jedes Call mit OE vorn schreiben.
+ Shift-Click auf Rf-Port-Knopf geht direkt in Config-Editor.
+ Portname nach dem Port-URL zeigt in "i"-Liste und beim "Hovern" auf den aktiven
Port knopf Namen und i p Nunmer.

+ On Next Click to Track mit "Zoom to" schaltet erst in den 1 User Modus

und tut dann (nun hoffentlich) die anderen aktivierten D nge.

3.7.2014 (Ver 0.38-testversion)
+ Baken sollten sichn nun auch mit den "\\" Macros wieder in den Editor laden
| assen ohne dass di ese expandi ert werden. (Vorhandene Objekt-Baken neu ei ngeben)
+ Message Routing verbessert mit automatischer "NOGATE"-Option wenn nur Funkports
verwendet werden

+ Message und Baken Sende-Meldung und Rueckfrage wenn man (meist versehentlich)

Leerzeilen Msg senden will.



4.7.2014 (Ver 0.38-testversion)

+ Logfile loeschen bzw. Filegroesse anzeigen + Etwas mehr "On Next Click"-Optionen kombinierbar

8. 7. 2014 (Ver 0.39-testversion)

+ WX grafik zeigen auch wenn WX Baken ohne WX Daten dabei sind + Schalter fuer nur WX-
Stationen auf der Karte zeigen

17.7. 2014 (Ver 0.40-testversion)
+ Nur WX Stationen auf der Karte Zeigen

+ Relief Karten rechnen mit Fortschrittsanzeige und nach 4s Abfrage

auf Abbruch (mt srtnm(1l) Files (netzwerk-laufwerk zu |l angsam und noch ohne
Antialiasing was ab zoom 12 sichtbar wird)

map paraneter/brightness rfpath zB. "30 100 50 100 80 20 0 100 100"

(der 3. Wert O fuer harten Kontrast/Funkrei chweite oder 500 fuer aufpeppen
von osm Karten)

tool s/radiolink "2000 O O 200" rmarker 1 und evtl marker 2 setzen und "R’
"config/brightness map" zum ei n/ ausbl enden der osm karte)

+ Digipeater (abgespeckte udpbox derzeit noch ohne klicker-Editor und nur grob getestet)

Config/ Rf-Ports/Digipeater, derweil Internes Format nit Zeil eneditor bearbeiten.

+ Message Sendetaetigkeit-popup-Meldungen verfeinert und korrigiert

18. 7. 2014 (Ver 0.40-testversion)

+ der Logfile-Pfad fuer das rawlog wird auch fuer die Watchcall-Logs verwendet

19. 7. 2014 (Ver 0.40-testversion)

+ Watchcall-Liste nach "longest-match” durchsuchen.

" OEOAAA" passt bei * OE* CEO* OEOB* auf OEO*
OE* +log / CE1X +log / CELl* nichts / CES5A +beep
schrei bt 1 og von oe ausser oel und oeba aber schon oelx und peept bei OE5A

+ Call-Log Filegroesse anzeigen und Files loeschen

20. 7. 2014 (Ver 0.40-testversion)

+ Cursor Up/Down Tasten in mehrzeiligen Textmenues + Tasten Fokus Lock auf Eingabefeld nach
Anklicken oder Tastatureingabe + 1. Klick auf eine Zeile veraendert nicht die Kursorposition

25.7. 2014 (Ver 0.41-testversion)



+ Digipeater, mit fein dosierbaren Standard (mach QRG voll) bis "sehr beruhigt" Optionen + Editor
dazu Config / Rf-Ports/ Digipeater und "Hints'

28.7.2014 (Ver 0.41-testversion)

+ Farbe fuer Schrift, Menues, Hintergrund, Transparenz, Radiorange, Reliefkarte

mt Farbauswaehl er (der noch 3eckig werden soll damt ungekehrt auch eingestellte
Farbe drauf gezei gt werden kann)

31. 7. 2014 (Ver 0.42-testversion)

+ Statusknopf zeigt durchgehend wenn Wx/Temp./Regen/Radiorange oder single User Modus ist

und kann da ausgeschal tet werden.

24. 8. 2014 (Ver 0.42)

+ "F"ind auf einen sonst unsichtbaren Objekt-Sender zeigt dessen Objekte.

+ "More Infos' zeigt Button "Objects of Call" wenn Call Objekte sendet.

+ Wx-only mit "L"abels off zeigt nur Temperatur und Windfahne beim Symbol.
+ Antennenwinkel bei Gelaendeschnitt Info.

+ "DUPE" Meldung bel Wegpunkt-Info nimmer "ewig" bei einer Fixposition nach einem

Ausr ei sser.

26. 8. 2014 (Ver 0.42)
+ ip-Nummer schreiberel vereinfacht, "127.0.0.1" kann weggel assen werden

+ udpflex erweitert auf "net-kiss"’, also kiss viatcp, damits mit dem

di re-wol f - Soundnodem kann "udpfl ex. exe -U :9002: 9001 -T :"
(http://home. contast. net/~wbh2o0sz/site/

geht mt default Einstellung, Sanpelrate sollte man aber hal bi eren
sonst ziehts 750MHz CPU)

15. 10. 2014 (Ver 0.43)
+ Input Filtern auf Stichwort im ganzen Frame

+ kleines "€" oder "d" im Map-expansion-Laempchen zeigt automatischer Map Download


http://home.comcast.net/~wb2osz/site/

off (toggle mit "d"), Manueller Map Rel oad/ Downl oad geht aber auch in dem Mdus.
+ Im"F"ind Feld geht auch dezimal Grad "48.2 13.31".
+ bel den Config Zeilen geht "Enter-Taste" als Ok oder Add.
+ Textfarbe vom Items/Objects mit Farbauswaehler unabhaegnig von normalen Baken
ei nstel | bar.
+ Fontgroesse Eingabe zeigt sofort Ergebnis.
+ ist ein Objekt im "show 1" modus, kann man mit "Focus" Karte mitziehn
ei nschal ten ohne Watchlisten Eintrag.

+ TAB-Taste schaltet zwischen 2 Kontexten hin und her, dazu zaehlt nebst

Wt t erkarten- Modi auch der "Focus" Mdus, wonit 2 Cbjekte imBild gehalten
wer den koennen.

+ Baken/Message/Ack Senden Warnmeldungen verbessert, wenn der eingestellte

Sendepfad vernutlich nicht zumErfolg fuehrt. (Port ausgeschaltet, nicht
zum Senden konfiguriert, kein Passcode amlInternet ....)

+ Gelaendeschnitt, Reichweiten-, Relief-K arten Parameter in ausfuehrlicherem

Menue zusammengef asst.
+ Gelaendeschnitt zeigt freie Meter zum Boden (Karte ziehen zum Messmarke bewegen)

+ Trackfilter beim Suchen auf Duplikate mit Indexsystem so verschnellert, dass

bei m aus dem Spei cher Entfernen von Wegpunkten, auch deren Fol gefehler nit
Entfernt werden koennen.

11. 11. 2014 (Ver 0.45)

+ Geleandeschnitt und Reliefkarten mit einstellbarem Hoehendaten Cache

damt Plattenzugriff auf etwa 0.5% verringert.

+ Schalter "kleine/mittlere/volle Aufloesung” entsprechend langsam bis schnell. + Interpolation der
Hoehendaten und damit brauchbare Bilder bis Zoom 14

+im"Find" Feld geht Call / Sender of Object / Locator / DDMM.MM / D.DDDD + Marker 1 setzen
Sendet DDMM.MM zum c/p Buffer, Marker 2 D.DDDDD Format.

9. 12. 2014 (Ver 0.46)



+ Watchcall Popup-Fenster anklickbar und zentriert Map auf das Objekt
+ Point-Of-Interest-File (osm/poi.txt) mit Name/Position/(optional) Hoehe

(als Beispiel ist ein File mt etwa 20000 mehr oder weniger richtigen
Al pengi pf el n vor handen)

+ mit "F" oder Tools->Find kann mit Wildcards (ste?n*) auf die Namen gesucht

werden und die Karte zentriert auf die Position und setzt Marker 1.
Bei nehreren passenden Nanen mit Enter oder Klick auf Find werden alle
Posi ti onen durchgesteppt.

+ist "p" oder Config->Map Parameter->Show Loc of Mouse auf ON, geht beim

Bewegen der Maus ei ne Sprechblase mt Zei ger zum naechst gel egenen Poi auf.
mt "c" kann die Karte drauf zentriert werden.

30. 12. 2014 (Ver 0.46)

+ Marker 1 und 2 setzen ("x" "y") geht ohne vorher auf die Karte klicken

gl ei ches bei Zentrieren "c¢" nmit dem Unterschied wenn ein PO maxi nal
5 Pixel entfernt angezeigt wird, exakt auf diesen zentriert wrd.

26. 1. 2015 (Ver 0.47)

+ nebst "poi.txt" wird noch "mypoi.txt" gelesen damit beim Update bei Bedarf

di e sel ber angel egten Punkte erhalten bl ei ben.
nun auch vi el e SOTA-Standorte i m poi.txt

+ Log File (rawlog) durch Anhaengen von %d zB. "logs/rawlog%d" auf tageweise

1 File mit Datumunstellbar. |Ist auch kompatibel zu den Logs am www Server.
(Log Filenane jetzt im"File" Menue)

+ Bel tageweisem Log einstellbar nach wieviel Tagen automatisch (beim Start
oder Mtternacht) Logs gel oescht werden soll en.

+ im Log suchen nach Datum und/oder Call sollte auch dank "Load" (fuer ab
ei ngegebenen Datum deutlich zuverl aessi ger gehen.

+ mehrfach eingetroffene selbe Message wird nur 1x Angezeigt.

+ Baken (Netzbake, Objekte) koennen Position aus File (auch in Grad mit Komma)

| esen fuer bewegliche Objekte oder Mbbil betrieb.



+ Baken koennen Text-Macro-File loeschen nach 1 mal Senden zum Zweck des

aut omati schen verstumens der Bake wenn zB das Wetterhaeuschen ni mrer Updatet.

2.3.2015 (Ver 0.48)

+ Nur Stationen mit einem bestimmten Symbol aufs Bild, Symbol-Wahl in

Tools / Select Data / Synmbol> On/Of mit "Synbol" oder "s"-Taste.
Achtung: Screenshot Taste ist jetzt "S".

+ Overlay Symbole mit Mausklick eingebbar

6. 3. 2015 (Ver 0.48)

+ Zoom-L upe aufziehen mit rechter Maustaste halten. Ohne Maus bewegen wie bisher

Backspace in der Zooni Pan Hi story oder (Copy/)Paste in Textei ngaben.

15.3. 2015 (Ver 0.49)

+ Hover Info Popup (Tools/On Next Click/Hover) auf den Symbolen und Glaendeschnitt

zu Marker 1 wenn Tool s/ Radi ol i nk enabl ed.

24.3. 2015 (Ver 0.49)

+ Linkstreckenberechnung mit einstellbarer Beugung (refraktion) der Hf in der Atmosphaere.

15.6. 2015 (Ver 0.49)

* "H" fuer Hoehendaten Farbdarstellung.
® Cache auch fuer nicht vorhandensein von Hoehendaten damits schneller mit Loechern im

Dat enmateri al zurecht komt.

® poi.txt ohne Neustart einlesen mit "Reload Config"”.
* \Wx Radioaktivitaet dekodieren und (vorerst) als Text ausgeben.

21.6. 2015 (Ver 0.50)

®* Maidenhead Locator Ausgabe langes Format, Eingabe "Find" 6 8 oder 10 stellig.
® Treiber Aufruf fuer Soundmodems und (USB-)serielle kiss/'smack TNC/Funkgeraete

betri ebssyst enspezi fi sch voreingestellt (sofern noch kein aprsmap.cfg vorhanden ist).



® Popup Fenster Ueberlappungen etwas seltener.
* Radioaktivitaet (Sievert) Dekodierung in den Wx-Baken (vorerst ohne Grafik)
® Getrennte Backspace/Rechte-Maus History fuer beide TABs

27.6. 2015 (Ver 0.50)

® etwas verbesserte popup Fenster Platzierung.
® Config > Map Parameter > Reset to Default oder kurz "D" stellt die meisten

Bi | dparaneter und Klickverhalten auf Default. Die alten Werte gehen zuvor in die
Backspace/ rechte Maus-Hi story zwecks Undo der Funkti on.

® History/TAB speichert die wichtigsten Bildparameter + Kartentyp.

6. 7. 2015 (Ver 0.52)

® Parameter Reset "ctrl-L" statt "D"
¢ dekodieren und darstellen vom Area-Objects, Kreis, Ellypse, Rechteck, Dreieck, Linie

(ohne Corridor) gefuellt oder leer in 8 Farben nach APRS101. pdf.

® Baken Editor erstmal fuer numerische Eingabe der Area Objects.
® dekodieren und darstellen von Multiline-Objects mit 3 Linientypen und 4 Farben nach AESPL

1-23 Linien pro Bake geschl ossen oder offen.

® Anklicken aller Linien und Flaechen am Rand und V erhalten wie normale Objekte aber ohne

Track bei Bewegung.

8.7. 2015 (Ver 0.52)

® Multiline-Objekt Editor

25. 8. 2015 (Ver 0.54)

* Mic-e-Telemetrie Dekoder, die Herstellercodes aus den Mic-e Frames werden dazu vorher

entfernt (soweits geht) was auch sauberere Komentarzeil en ergibt.

16.10. 2015 (Ver 0.56)

* Wetterbake (Netbeacon, Rf Beacon, Query) aus .csv File

\WIwx. csv,,,t,,,,, h,b,r,wd,,,,, g! imcoment extrahiert die Werte aus der letzten Zeil
imFile wx.csv. Es kann noch ein Miltiplikator angegeben werden zb. ,w3.6, statt ,w, 2zl
Umrechnen von ni's auf knmih. Werte siehe Hints. W« Synbol auswaehl en.



®* Messages/Queries bei 9-stelligem Mycall sollten nun bestaetigt/beantwortet werden.

24.11. 2015 (Ver 0.58)

* \Wx Grafiken korrigiert
¢ Schaltknopf/Laempchen fuer Objekte Ein/Aus
® Gate Net-to-Rf mit Radius und Bit/s Limit und Option nur Message zu (gehoerten) Usern

(mt Standard-3rd-party Protokoll und ohne spei chern/w ederhol en von Messages).
Ei nschalten mt Config/Rf-Ports/Digipeater, Rx auf "N', Bit/s in "N-n Wrds" siehe Hint

28.11. 2015 (Ver 0.58)

¢ Starten ohne "terminal” und Abstellen sollte ohne X 11 abschmieren gehen.
® UDP Ports an und abschalten auch mit laufendem "seria interface”.

29.11. 2015 (Ver 0.58)

® History bel der "Find" Zeile mit Cursor up/down.
¢ Rf-Monitor mit Txdelay, Level und Quality, sofern vom Modem geliefert (af skmodem linux).
* Fenster Kopfzeile "nur neue" Calls (Config/rf-ports/monitor headline 0) und Zeit seit

| etztem mal gehoert(1).

7.1. 2016 (Ver 0.59)

® "Storm Data' Auswertung und Flaechen-Darstellung mit interpolierter Animation.

(rmangel s Akt uel | er Testdaten nach APRS101. pdf in nautischen Meilen 1.609km

® Area, Multiline-, Sturm-Objekte mit "<>" durchsteppen mit zum Wegpunkt gehoerender

FI aechendar st el | ung.

23.1.2016 (Ver 0.59)

® |temin Messages, (B)akeneditor (auf "Item™) + (M)essage Send Fenster geoeffnet

kopi ert den Bakeninhalt in Message Text und erzeugt dann bei m Enpfaenger der Mg

ein Synbol auf der Karte. (APRS1. 2)

Da sich die Protokollerweiterung Item Message und Multiline-Cbject gegenseitig

bei ssen ("{" synbol), geht die Konbination vernutlich nur nit aprsmap + send with ack.

25.5.2016 (Ver 0.61)

® Objekte ohne Richtung und Geschwindigkeit zeichnen keinen Track mehr.
¢ dleaternativ Symbole koennen Overlay Zeichen haben (a..z A..Z 0..9)
® Hamnet Symbol in symbols.png



15.3.2017 (Ver 0.64)
® Trackfilter geht bei mehr als 15000 Wegpunkten nimmer gegen Rechenzeit unendlich.

® Trackfilter wird auch mit den kleinen Zappeleien bei Verzoegerungen unter 1IMin fertig.
® "Find Item Message" zeigt auch bei mehreren solchen Msgs die dazu passende Position.

5.4.2017 (Ver 0.65)

® Rotes Fehlermel dung-Popupfenster groesser und umfangreicher bei der Baken Eingabe.
® mit []-Tasten Zeit aendern wie lang Dinge auf der Karte sichtbar bleiben.

25.5.2017 (Ver 0.66)

+ Kontrast der Symbole verbessert. + Fenster zu klicken sollte bei vielen Linux-Fenstermachern
wieder geeordnet abstellen. + Linux 64bit Version.

5.7.2017 (Ver 0.67)

+ langen Locator suchen korrigiert und Kleinfeld Darstellung + udpflex (linux) tcpkiss server

20.9.2017 (Ver 0.69)

+ Helligkeitskorrektur (Tools > Add Maptypes) als Gamma Werte statt +- Helligkeit. Bei Bildschirm-
Gamma (Config > Brightness) 2.2 entspricht 0.45 original und 0.3 etwa dem bisherigen -128. Die
Werte werden nun bel Kontextumschaltung mit TAB mit dem Kartentyp gespeichert.

h264 in mpeg4 Container: Linux: 1 mal machen: mknod map.y4m p

fuer jedes Video starten: x264 -o filmnp4 --nmuxer nmp4 --crf 22 nmap. y4m
<Make Vi deo>

win: File/ Make Video gibt unkomprimiertes Videofile map.y4m

(.y4m sol lten nmpl ayer oder vlc abspiel en koennen)

kl ei n packen mt x264.exe "x264 -o filmnp4 --nuxer np4 --crf 22 map.y4nt
(crf=22..27 qualitaet gut bis sparsan

vorher mt Animate und auf Map klicken passende Geschwi ndi gkeit einstellen

filed/dirs:
apr smap progranmm
aprsmap. cfg bei spi el config, wenn nicht vorhanden werden default werte erzeugt
hi nts. txt ti pps beimverweilen mt der nmaus auf buttons
hel p. t xt Hyperlink-Hi | fetext unter Help > Hel ptext

gm sh shel |l script zum osm karten hol en



synbol s. png
font. png
gettiles
raw og

osnmtiles/
osmtiles_sat/
osntiles_topo/
udpf | ex

ki sson. t xt

get osm exe
poi . t xt

nypoi . t xt

oebdx|

(geht nun auch mit der busybox amtinycore) ./gmsh
(darf/soll verbessert werden H)

i cons

buchst aben

vom aprsmap erzeugte liste fehlender map tiles

ti mestanmp+aprsis format wenn vorhanden bei m start ei ngel esen
bei connect zu aprs server komts neue dazu

dargestellt werden die eingestellten mnuten vomende des | ogs
mt connect zu server eingestellte minuten von jetzt

file darf editiert, beschnitten, gefiltert werden

wird nach tinmestanp sortiert eingel esen

(langes file einlesen geht mt serverconnect schneller

da erst ab "jetzt-darstellzeit" decodiert wird)

karten i mosm f or nat

axudp<->ki ss/ smack/fl exki ss interface fuer TNC, TM7xx ..
kiss initialisierung fuer TMD72 mit udpfl ex

W n: Schneller Mplader von OE5KRN

gl obal es/ privates

Points-Of-Interest-File mt aktiviertem"p" zum zei gen be
Mauszei ger naehe oder Suchen mt "F"

<< Zuriick zur DXL-APRSmap Ubersicht
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